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Windows Driver Installation 
Before continuing, make sure that your computer has a 6-Pin FireWire or IEEE-1394 
port built in or as an expansion card.  If you only have a 4-pin connector then you need 
to contact a local computer store or Scion Corporation for a 4-pin to 6-pin adapter.  If 
you do not have a FireWire or IEEE-1394 port then you will need to contact a local 
computer dealer for a PCI or CardBus expansion card. 

 
The Scion Monochrome and Color Firewire cameras require Windows Vista 32-Bit, 
Windows XP or Windows 2000.  Please note that Windows Vista 64-Bit is not yet 
supported. 

 
Windows Vista 32-Bit 
Currently Scion only has support for the 32-bit version of Windows Vista.  A user 
with Administrator access rights must install drivers. 
 

1. Unpack the camera, cable and power supply. 
2. Plug the power supply into the wall outlet. 
3. Plug the FireWire cable to the FireWire port on the computer. 
4. Plug the other end of the FireWire cable into the camera. 
5. At this point make sure that the “Scion Camera Software” CD is in the 

computer CD-ROM or DVD drive. 
6. Plug the other end of the power supply into the camera. 
7. The “Found New Hardware” window will appear. 
8. Select “Locate and install driver software (recommended)”. 
9. A User Account control dialog will appear asking for permission to install the 

device.  If logged in as a Standard User then enter the administrator password.  
If logged in as an administrator then click “Continue”. 

10. Windows will start a search for the driver.  A window will appear asking to 
insert the CD.  Check that it is inserted and click the Next button. 

11. A window will appear alerting the user that it cannot verify the publisher of 
the software.  Select “Install this driver software anyway”. 

12. A new window will appear after a short time showing that the driver was 
installed successfully.  Click the Close button to finish the driver installation. 

13. Continue to the Windows Software Installation section. 
 

Windows XP 
1. Unpack the camera, cable and power supply. 
2. Plug the power supply into the wall outlet. 
3. Plug the FireWire cable to the FireWire port on the computer. 
4. Plug the other end of the FireWire cable into the camera. 
5. At this point make sure that the “Scion Camera Software” CD is in the 

computer CD-ROM or DVD drive. 
6. Plug the other end of the power supply into the camera. 
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7. The Found New Hardware Wizard will appear. 
8. Select “Install the software automatically (Recommended)”.  Then click the 

Next button. 
9. Windows will search for the driver.  Click the Next button to continue. 
10. The files are then copied. 
11. Click the Finish button to complete the driver installation. 
12. Continue to the Windows Software Installation section. 

 
Windows 2000 

1. Unpack the camera, cable and power supply. 
2. Plug the power supply into the wall outlet. 
3. Plug the FireWire cable to the FireWire port on the computer. 
4. Plug the other end of the FireWire cable into the camera. 
5. At this point make sure that the “Scion Camera Software” CD is in the 

computer CD-ROM or DVD drive. 
6. Plug the other end of the power supply into the camera. 
7. The Found New Hardware Wizard will appear. 
8. Click Next to Continue. 
9. Select “Search for a suitable driver for my device (Recommended)”.  Then 

Click the Next button. 
10. In the “Optional Search Locations” select “CD-ROM drives” and have 

nothing else checked.  Click the Next button to continue. 
11. Windows will then search and find the drivers.  Click the Next button to 

continue. 
12. The drivers will then be copied and installed. 
13. Click the Finish button to complete the driver installation. 
14. Reboot the computer if asked to do so. 
15. Continue to the Windows Software Installation section. 
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Mac OS X Driver Installation 
Before continuing, make sure that your computer has a 6-Pin FireWire or IEEE-1394 
port built in or as an expansion card.  If you only have a 4-pin connector then you need 
to contact a local computer store or Scion Corporation for a 4-pin to 6-pin adapter.  If 
you do not have a FireWire or IEEE-1394 port then you will need to contact a local 
computer dealer for a PCI or CardBus expansion card. 
 
The Scion Firewire cameras require Mac OS 10.4 or higher.  This is a Universal 
Binary driver for those using Intel-Based Macintosh computers or PowePC-Based 
Macintosh computers. 

 
1. Insert the “Scion Camera Software” CD into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. Double-click the “Drivers” folder to open it. 
4. Double-click the “sfwdisk.pkg.tar.gz” file. 
5. It will expand into “sfwdist.pkg” located on the desktop. 
6. Double-click the “sfwdist.pkg” file located on the desktop.  The installer will 

start. 
7. Authentication is needed to continue the installation.  An administrator login 

is needed. 
8. Click the Continue button. 
9. Click Continue again to accept the destination folder. 
10. Click Continue after reading the license agreement. 
11. You must agree to the terms of the license agreement to continue. 
12. Select the destination disk and click the Continue button. 
13. Click Install to start the installation. 
14. The installation may take a few minutes. 
15. After the install is complete click the Close button. 
16. The file “sfwdist.pkg” may now be deleted from the desktop. 
17. Unpack the camera, cable and power supply. 
18. Plug the power supply into the wall outlet. 
19. Plug the FireWire cable to the FireWire port on the computer. 
20. Plug the other end of the FireWire cable into the camera. 
21. Plug the other end of the power supply into the camera. 
22. Continue to the Mac OS X Software Installation section. 
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Windows Software Installation 
The Scion Monochrome and Color Firewire cameras require Windows Vista 32-bit, 
Windows XP or Windows 2000.  Please note that Windows Vista 64-Bit is not yet 
supported. 

 
Scion VisiCapture 
The VisiCapture program is a general capturing program for the Scion FireWire 
cameras.  The program can change capture settings of the camera and save images in 
several image formats. 
 

1. Insert the “Scion Camera Software” CD into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not appear 

then open Windows Explorer and find the CD-ROM. 
3. Double-click the “VisiCapture“ folder. 
4. Double-click the “VisiCapture.exe“ to start the installation. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the on screen prompts and choose a destination for the software. 
7. Once the installation is complete, the program can be launched from the Start 

Menu.  Upon launch the VisiCapture program will automatically start 
capturing. 

8. See the documentation for further details about the Scion VisiCapture 
program. 

 
Scion 1394 Java Package for ImageJ 
The ImageJ program is a freeware image analysis program developed by the NIH.  
The plugins will allow the user to capture images into the ImageJ program for later 
saving and analysis. 
 

1. Insert the “Scion Camera Software” CD into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not appear 

then open Windows Explorer and find the CD. 
3. If installing the ImageJ program for the first time then double-click the 

“ImageJ” folder.  If adding Scion 1394 Camera capture support to an already 
existing version of ImageJ then double-click the “ImageJ Update” folder. 

4. Double-click the “SFW_ImageJ.exe” file to start the installation.  If you are 
using the Update version then double-click the “SFW_ImageJ_Update.exe” 
file. 

5. If running Windows Vista, a User Account control dialog will appear asking 
for permission to run the installation.  If logged in as a Standard User then 
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enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the on screen prompts and choose a destination for the software. 
7. Once the installation is complete, the program can be launched from the Start 

Menu. 
8. Once ImageJ is running, go to the Plug-ins menu and select “Live” from the 

“1394 Camera” submenu. 
9. See the documentation that is installed with the program for more information.  

 
Scion Camera Driver for Micro-Manager 
Micro-Manager is an Open Source software package for imaging and control of 
automated microscopes.  Support has been added for all Scion Cameras. 
 

1. Insert the “Scion Camera Software” CD into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not appear 

then open Windows Explorer and find the CD. 
3. Double-click the “Micro-Manager” folder. 
4. Double-click the “SFW_MM.exe” file to start the installation. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the on screen prompts and choose a destination for the software.  
Make sure to install this in the same location as your current installation of the 
Micro-Manager program. 

7. Now that the installation is complete, the Micro-Manager program can be run. 
8. Once Micro-Manager is running the “MMConfig_scion.cfg” can be loaded.  

This shows example settings for the Scion FireWire Cameras and can be 
modified. 

9. See the documentation that is installed with the program for more information 
on configuration settings. 

 
Scion TWAIN 1394 Camera Import 
The TWAIN module will allow the user to capture images into any TWAIN compliant 
program like Photoshop. 
 

1. Insert the “Scion Camera Software” CD into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not appear 

then open Windows Explorer and find the CD. 
3. Double-click the “TWAIN“ folder. 
4. Double-click the “SFW_TWAIN.exe“ file to start the installation. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
enter the administrator password.  If logged in as an administrator then click 
“Allow”. 
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6. Follow the on screen prompts and choose a destination for the software. 
7. After installation is complete, the computer may require a restart.  
8. All programs that have support for TWAIN will now have the ability to 

capture with the Scion FireWire Cameras. 
9. In Photoshop 6.0 or higher, select “Import” from the “File” menu.  From this 

menu choose “Scion 1394 Camera Import”.  The module will then open. 
10. From the “Image” menu select “Start Live Capturing” to start capturing. 
11. See the documentation that is installed with the program for more information. 

 
Scion 1394 Camera Driver for Image-Pro 
Image-Pro is an image analysis package developed by Media Cybernetics.  Use this 
capture driver to capture images directly into the Image-Pro program.  Image-Pro is 
required for installation. 
 

1. Insert the “Scion Camera Software” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not appear 

then open Windows Explorer and find the CD. 
3. Double-click the “Image-Pro Capture Driver“ folder. 
4. Double click the “SFW_ImagePro.exe“ to install. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the on screen prompts making sure to install to the current Image-Pro 
folder. 

7. In Image-Pro select “Video/Digital Capture” from the “Acquire” menu. 
8. Click the “More” button in the dialog and select the “Scion 1394 Camera 

Driver” from the “Current Driver” box. 
9. You can then click the “Preview” button to start capturing. 
10. See the documentation that is installed with the program for more information. 

 
Scion 1394 LabVIEW VI 
LabVIEW is a graphical programming language program from National Instruments.  
Scion has created virtual instruments or VI’s to allow the capture of images into the 
LabVIEW program.  LabVIEW is required for installation. 
 

1. Make sure that the “Scion Camera Software” CD is inserted into the CD-
ROM or DVD drive. 

2. A window containing the contents of the CD will appear.  If it does not appear 
then open Windows Explorer and find the CD. 

3. Double-click the “LabVIEW VI” folder.   
4. Double-click the “SFW_LV.exe” file to start the installation. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
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enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the onscreen prompts and choose a location to install the program. 
7. Once the installation is complete the VI’s will be available in LabVIEW. 
8. See the documentation that is installed with the program for more information. 

 
Scion 1394 Camera Software Development Kit 
The Software Development Kit or SDK has been included for those that wish to 
integrate the Scion Cameras into their programs. 
 

1. Make sure that the “Scion Camera Software” CD is inserted into the CD-
ROM or DVD drive. 

2. A window containing the contents of the CD will appear.  If it does not appear 
then open Windows Explorer and find the CD. 

3. Double-click the “SDK” folder. 
4. Double-click the “SFW_SDK.exe” file to start the installation. 
5. If running Windows Vista, a User Account control dialog will appear asking 

for permission to run the installation.  If logged in as a Standard User then 
enter the administrator password.  If logged in as an administrator then click 
“Allow”. 

6. Follow the onscreen prompts and choose a location to install the program. 
7. After the installation is complete find the “Scion 1394 Camera SDK” folder 

and read the documentation for further information. 
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Mac OS X Software Installation 
The Scion Monochrome and Color Firewire cameras require Mac OS 10.4 or higher. 

 
Scion VisiCapture 
The VisiCapture program is a general capturing program for the Scion FireWire 
cameras.  The program can change capture settings of camera and save images in 
several image formats. 
 

1. Insert the “Scion Camera Software CD” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. Double-click the “VisiCapture” folder. 
4. Double-click the “visicapture.pkg.tar.gz” file. 
5. It will expand into “visicapture.pkg” located on the desktop. 
6. Double-click the “visicapture.pkg” file located on the desktop.  The installer 

will start. 
7. Click the Continue button. 
8. Click Continue after reading the license agreement. 
9. You must agree to the terms of the license agreement to continue. 
10. Select the destination disk and click the Continue button. 
11. Click Install to start the installation. 
12. The installation may take a few minutes. 
13. After the install is complete click the Close button. 
14. The file “visicapture.pkg” may now be deleted from the desktop. 
15. By default the program is installed in the “Applications” folder under the 

“VisiCapture” folder. 
16. Upon launch the VisiCapture program and it will automatically start 

capturing. 
17. See the documentation that is installed with the program for more information. 

 
1394 Camera Java Package for ImageJ 
The ImageJ program is a freeware image analysis program developed by the NIH.  
The plugins will allow the user to capture images into the ImageJ program for later 
saving and analysis. 
 

1. Insert the “Scion Camera Software CD” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. If installing the ImageJ program for the first time then double-click the 

“ImageJ” folder.  If adding Scion 1394 Camera capture support to an already 
existing version of ImageJ then double-click the “ImageJ Update” folder. 

4. Double-click the “SWFImageJ.sit.gz” file to start the installation.  If you are 
using the Update version then double-click the “sfwju.pkg.tar.gz” file. 
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5. It will expand into a folder on the desktop called “ImageJ”. 
6. Double-click the “ImageJ” folder and Double-click the “ImageJ” icon located 

in the folder to launch the program. 
7. Once ImageJ is running go to the Plug-ins menu and select “Live” from the 

“1394 Camera” submenu. 
8. See the documentation that is installed with the program for more information. 

 
Scion Camera Driver for Micro-Manager 
Micro-Manager is an Open Source software package for imaging and control of 
automated microscopes.  Support has been added for all Scion Cameras. 
 

1. Insert the “Scion Camera Software CD” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. Double-click the “Micro-Manager” folder. 
4. There are two installations available.  The “SFWMicroManager_Intel.dmg” 

supports Mac computers that are running with the Intel processor.  The 
“SFWMicroManager_PPC.dmg” supports older Mac computers with the 
PowerPC processor.  Double-click the appropriate file to mount the 
installation volume. 

5. A new icon will appear on the desktop.  Double-click the 
“ScionCam_mmgr_Mac” icon to open the volume. 

6.  Here you will find the Scion Camera Driver manual for Micro-Manager and 
the “Micro-Manager” folder. 

7. The “Micro-Manager” folder can be copied to the desktop or to the 
Applications folder by just dragging the folder to one of these locations. 

8. Double-clicking the “Micro-Manager” folder and then double-clicking the 
“ImageJ” icon will start Micro-Manager.  

9. Once Micro-Manager is running the “MMConfig_scion.cfg” can be loaded.  
This shows example settings for the Scion FireWire Cameras and can be 
modified. 

10. See the documentation that is installed with the program for more information 
on configuration settings. 

 
Scion TWAIN 1394 Camera Import 
The TWAIN module will allow the user to capture images into any TWAIN compliant 
program like Photoshop. 
 

1. Insert the “Scion Camera Software CD” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. Double-click the “TWAIN” folder. 
4. Double-click the “sfwtwain.pkg.tar.gz” file. 
5. It will expand into “sfwtwain.pkg” located on the desktop. 
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6. Double-click the “sfwtwain.pkg” file located on the desktop.  The installer 
will start. 

7. Click the Continue button. 
8. Select the destination disk and click the Continue button. 
9. Click Install to start the installation.  The installation may take a few minutes. 
10. After the install is complete click the Close button. 
11. The files “sfwtwain.pkg.tar.gz” and “sfwtwain.pkg” may now be deleted from 

the desktop. 
12. All programs that have support for TWAIN will now have the ability to 

capture with the Scion FireWire Cameras. 
13. In Photoshop 6.0 or higher, select “Import” from the “File” menu.  From this 

menu choose “Scion 1394 Camera Import”.  The module will then open. 
14. From the “Image” menu select “Start Live Capturing” to start capturing. 
15. See the documentation that is installed with the program for more information. 

 
Scion 1394 Camera Software Development Kit 
The Software Development Kit or SDK has been included for those that wish to 
integrate the Scion Cameras into their programs. 
 

1. Insert the “Scion Camera Software CD” into the CD-ROM or DVD drive. 
2. A window containing the contents of the CD will appear.  If it does not then 

double-click the “Scion CD” icon located on the Desktop. 
3. Double-click the “SDK” folder. 
4. Double-click the “sfwsdk.pkg.tar.gz” file. 
5. It will expand into “sfwsdk.pkg” located on the desktop. 
6. Double-click the “sfwsdk.pkg” file located on the desktop.  The installer will 

start. 
7. Click the Continue button. 
8. Click Continue after reading the license agreement. 
9. You must agree to the terms of the license agreement to continue. 
10. Select the destination disk and click the Continue button. 
11. Click Install to start the installation.  The installation may take a few minutes. 
12. After the install is complete click the Close button. 
13. The file “sfwsdk.pkg” may now be deleted from the desktop. 
14. By default the program is installed in the “Applications” folder under the 

“Scion FW SDK” folder. 
15. See the documentation that is installed with the program for more information. 
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Feel free to contact Tom Morton for technical support at 301-695-7870 or E-Mail at 
support@scioncorp.com. 
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